E/IP PoE

Configuration and User Manual for PLC and PAC
Thank You!

Congratulations on the purchase of your E/IP PoE device. RF IDeas hopes you enjoy using our products as much as we enjoyed creating and developing them. Configuration is easy, so you will be able to quickly take advantage of a more secure environment in your business, school, or organization.

Visit [www.RFIDeas.com](http://www.RFIDeas.com) and follow the Support ➔ Learning Center link for more details about our additional product lines.

We look forward to your comments and suggestions for our various product lines. We are always discovering new applications and have several software developer’s licensing our technology so the solution you are looking for may already be developed.

Please call our sales department if you have any questions or are interested in our OEM or Independent Developer’s programs.

Thank you,
The RF IDeas Staff

Need Assistance?

Ph: 847.870.1723  
Fx: 847.483.1129  
E: Sales@RFIDeas.com  
TechSupport@RFIDeas.com
## Glossary Of Terms

<table>
<thead>
<tr>
<th>Terms</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACP</td>
<td>ASCII Command Protocol</td>
</tr>
<tr>
<td>BootP</td>
<td>Ethernet Boot Protocol</td>
</tr>
<tr>
<td>CSN</td>
<td>Card Serial Number</td>
</tr>
<tr>
<td>EIP</td>
<td>Ethernet Industrial Protocol</td>
</tr>
<tr>
<td>PoE</td>
<td>Power over Ethernet</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller</td>
</tr>
<tr>
<td>SDK</td>
<td>Software Developer’s Kit. Software Developer’s Kits from RF IDEas provide the high level command capabilities to integrate software applications to our devices.</td>
</tr>
<tr>
<td>UID</td>
<td>Unique Identifier</td>
</tr>
</tbody>
</table>

## Information Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎧</td>
<td>Note</td>
<td>Notes refer to useful information related to the text.</td>
</tr>
<tr>
<td>🔴</td>
<td>Tip</td>
<td>Tips can provide hints and pointers in addition to the text.</td>
</tr>
<tr>
<td>🚨</td>
<td>Important</td>
<td>Important information can include prerequisites, limitations or cautions.</td>
</tr>
</tbody>
</table>
## Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

## Information Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

## Chapter 1. The Basics

1.1 Standard .............................................. 5  
1.2 Power Supply ....................................... 5  
1.3 Equipment Needed ............................. 5  

## Chapter 2. Getting Started

2.1 Setting Up the E/IP Reader for Use... 6  
2.2 Making the Basic Network Connections ......................................................... 6  
2.3 Establishing an IP Address............. 7  
2.4 Reader Configuration ....................... 7  
2.5 Configuring IP and Internal Data Mode from a Web Browser ....................... 8  
2.6 Configuring IP and Internal Data Mode from a Telnet Session .......... 10  
2.7 Configuring the Reader from pcProx Config .............................................. 13  
2.8 Configuring the Reader Through ACP Commands ........................................ 14  

## Chapter 3. RS Linx Classic

3.1 RS Linx Classic Setup ....................... 19  

## Chapter 4. Rockwell Setup

4.1 Rockwell Studio 5000 Setup ........... 21  
4.2 RS Logix 5000 Configuration Release 13 Through 19 ........................................ 23  
4.3 Control Tags ................................. 24  
4.4 Obtaining User Credential Data ...... 26
Chapter 1. The Basics

1.1 Standard

The PoE reader follows the IEEE 802.3af-2003 standard. The reader communicates using the widely adopted Ethernet/IP industrial protocol for interfacing to factory PLC’s and related devices.

1.2 Power Supply

The PoE (Power over Ethernet) reader receives power from an upstream power supply. Power is delivered over the Ethernet cable per the IEEE 802.3af-2003 adopted PoE standard. Power is provided by a PoE router, Ethernet switch or can be injected into the cable with an additional mid span power supply.

Power injectors are available over the counter in most computer hardware stores or from catalog providers.

Power is supplied to the reader over the Ethernet connection in common mode over two or more pairs of wires on a PoE enabled network.

1.3 Equipment Needed

- Allen Bradley / Rockwell E/IP or compatible PLC, PAC or equivalent
- RJ45 patch cable
- PoE capable network port, local router or power injector (not included).
- PC (for initial setup) running:
  - Microsoft Windows
  - Rockwell RSlogix 5000, Studio 5000 or other programming tool
  - Telnet or other serial communications software and/or pcProxconfig5 application
2.1 Setting Up the E/IP Reader for Use

The configuration of the reader in most installations requires minimal changes for implementation. However, there are different options for configuring the reader. In any of these situations, setup may need to be done in at least one of the methods described in this manual.

Follow the details to establish the communication settings and credential formats that you will need in order to get the end application running correctly for the first time.

A typical installation will involve the following:

1. Making basic network connections
2. Installing EDS file where required
3. Establishing an IP address for the reader
4. Configuring the data mode: Listen or Polling
5. Configuring the reader credential type(s) and associated data format
6. Configuring the PLC Assembly instance
7. Writing the end PLC application code
8. Installing the reader at the installation site

2.2 Making the Basic Network Connections

The reader must be connected to a PoE capable connection to provide power to the reader and its communication dongle. For direct connection to the PLC, a simple network crossover cable can be used through a power injector once the reader is configured.

Connect the reader to the PoE capable port. If a PoE capable port is not available, or for temporary configuration purposes, a power injector can be used.

⚠️ If using a power injector, refer to the manual included with the power injector for instructions on proper connection.

Once the PoE network provides power to the reader a beep will be heard and the LED will illuminate red indicating the physical connection has been made and the port is powering the reader.
2.3 Establishing an IP Address

Once the physical connections have been made, the reader will request an IP address from the router or server as a Bootp device. A dynamic address can be assigned by the network. Dynamic addresses can change as other devices are added to the network the PoE device is connected to. Static IP addresses are constant, and therefore recommended.

Most networks do not support BootP directly. On the administrator PC the Rockwell BootP Server may be used to assign an IP address. RsLinx or RsLinx Classic may also be used. An IP address pool should be established for large quantity reader deployment. For a direct PLC to reader connection; a static IP address is required. The next section details how to assign an IP address using the BootP utility from Rockwell.

BootP Quick Setup

1. Take note of the MAC address from the side panel of the PoE dongle.
2. Download and install the Rockwell BootP Server on the PC containing your RS Logix 5000 programming suite. A standalone BootP server can be obtained from Rockwell. A copy can be obtained from our website at www.RFIDeas.com/support/downloads
3. Start the BootP Server application.
4. Double click on the MAC address noted earlier from the side of the PoE dongle which should be displayed in the Request History.
5. In the dialog box that appears, fill out your IP, name and description.
6. Be sure that the IP is displayed correctly in the Relation list and close the BootP server.
7. Save the settings to your Bootp Config File when prompted.

2.4 Reader Configuration

The reader requires some configuration prior to use. There are many ways to configure the reader.

The IP address and internal mode can be configured through:

- A web browser, OR
- Through a telnet to port 9999

The reader can also be configured to change:

- Credential ID types supported
- Set the device logical unique ID
- Format the ID data output

To configure changes, the pcProx Config utility can be downloaded OR direct configuration can be performed through a telnet session to port 10001.
In any situation, the reader will first need to have its IP address assigned and the internal data mode be set.

2.5 Configuring IP and Internal Data Mode from a Web Browser

From the web browser, type in the local IP address assigned to the PoE E/IP reader as shown below.

Example: //52.46.49.44

**Configuration Options**

**BOOTP Enabled**: When checked, this will enable the bootstrap protocol. Unchecked will allow static IP address configuration.

**IP Address**: Displays the current IP address in the text box. Here, the IP address of the PoE Reader can be edited if BOOTP is disabled. The address can be either dynamically assigned DHCP or a static IP address.
Subnet Mask: Displays the current Subnet mask in the text box. Here, the subnet mask used by the PoE reader can be edited. Typically for most networks, the subnet mask will be 255.255.255.0

Gateway: Displays the current Gateway used by the PoE reader. Here, the Gateway path can be edited. Set to 0.0.0.0 if the gateway will not be used.

Serial Tunnel TCP Port: Displays the current port address of the serial over Ethernet tunnel. Here, the TCP Port used by the serial tunnel can be edited. Default is 10001 and typically does not need to be changed.

The TCP serial tunnel should not be set to port 80 or 9999, as port 80 is reserved for the web configuration menu and 9999 is reserved for the telnet configuration menu.

Internal Mode: Displays two radio button choices. Select either “Listen for Card Reads” or “ACP QID Poll” depending on your intended use (See “Configuring the Internal mode” for further information).

**Internal mode**

By default, the internal data mode is set to Listen Mode. If this is the mode desired and a standard RF IDeas reader is attached (81 in the model name), this step can be skipped.

If the reader is an SDK model (82 in the model name) the mode must be set to polling mode.

The PoE for PLC reader module offers two data modes to send data over the E/IP network to the PLC, Listen mode and Polling mode.

**Listen Mode**

The Listen Mode utilizes the reader’s asynchronous serial communication to send ID data. When an ID is presented under listen mode:

- Sequence number is incremented
- ID bit count field is set to one
- ID data will be present

The data sent to the PLC will be valid as long as the ID remains present in the reader’s communication field. Once the card is removed the reader module will clear the ID data available to the PLC.

This mode will set a one in the ID Bit Count field when data is available giving a boolean method of triggering on card presence in addition to the sequence number.

Listen mode offers the ability to adjust the data sent from the reader to simplify some programming at the PLC level. The valid ID length can be set in the reader so only valid data lengths are acknowledged when present.

Depending on the data sent, listen mode can be the fastest method of retrieving ID data.
Polling Mode
The Polling Mode sets the reader to poll for updated ID data continuously. When an ID is presented to
the reader in polling mode:

- Sequence number is incremented
- ID Bit Count Field reports the ID bit count
- ID Data will be present

The data sent to the PLC will be valid as long as the ID remains present in the reader’s
communication field. Once the card is removed the reader module will clear the ID data available to
the PLC.

This method offers the addition of an ID Bit Count in the assembly instance that can be used to verify
the ID is the correct data length.

The valid ID length can also be set in the reader so only valid data lengths are acknowledged when
present.

2.6 Configuring IP and Internal Data Mode from a Telnet Session

From Windows, click Start ➔ Run and then type CMD to access the command line window.

From the command prompt, type telnet, the assigned IP address of the PoE reader followed by
9999.

Ex: c:\>telnet 52.46.49.44 9999.

Once connected, the user will be prompted to enter setup mode:

![Image 2: Command Prompt Entering Setup Mode](image)
This will bring up the configuration menu options.

If the telnet session fails to connect, verify the IP address has been entered correctly.

**Telnet Menu Options**

![Image 3: Telnet Setup Menu](image.png)

**0 – Server Configuration**

Edit the server IP address currently assigned to the PoE reader

Enter the IP address when prompted.

The device will display the current entry in brackets (xx). Pressing enter will advance to the next number entry.

After the IP address has been edited, the user will be prompted to enter the subnet mask in the same manner.

Once all edits have been made, “set Gateway IP Address (N)” will appear. Press Y then Enter to change to an alternate gateway address. Otherwise, press Enter at the prompt to leave the entry as it is.

In most configurations, it is not necessary to edit the Gateway setting.

The user will then be prompted with “Serial Tunnel TCP Port: (10001)?” Here, the user can change the port address of the serial over Ethernet tunnel. The default is set to 10001. It can be
changed to any non-conflicting port address that is not presently in use.

⚠️ Port 80 is reserved to the web configuration menu. Port 9999 is reserved to the Setup menu.

In a typical configuration, it is not necessary to edit this port setting.

Pressing Enter will accept all changes and return to the main menu.

At this point the settings have not been saved.

To save the changes, press 9 and Enter from the main menu.

1 – ACP Client Configuration
Sets the “ACP Client Mode” and “ACP Poll Interscan Delay”. The user can select either “Listen” or “Poll” modes. “Listen” allows the device connected to listen for a card to be read. “Polling” allows the user to continuously poll the reader every 250 ms to 2 seconds for changes in the ACP QID (Queued ID).

Pressing 1 and then Enter will display “ACP Client Mode (0=Listen, 1=Poll): (1)?” The default is set to 1.

Pressing Enter again will display “ACP Poll Interscan Delay (250..2000 ms): (250)?”

See Input / Output Assembly options.

6 – Debug
Sets the PoE to continuously read out the packet transfers. Press Escape to stop the process.

7 – Factory Defaults
Resets the PoE to defaults.

This function will not reset the Server configuration (IP address, gateway or subnet Mask)

8 – Exit without Save
This option will exit the setup menu without saving any changes made since the start of the session.

9 – Exit with Save
This option will exit the setup menu and save any changes made since the start of the session.
2.7 Configuring the Reader from pcProx Config

By default, all readers are shipped to detect standard ID formats and a typical data length for the model. Data formatting can be changed to the appropriate format through a variety of commonly used settings to achieve the data output required in the application.

The pcProx Plus® line of readers can be configured to the desired ID type by choosing from different standard brands and/or formats.

If additional configuration is necessary for the reader to work in the intended application, this can be done by using the pcProx Config application or directly through the serial over Ethernet tunnel using a telnet session.

**Configuration using pcProx Config**

Download and install the pcProx Config application version 5.0.4 or higher for the reader type purchased from our website at [www.RFIdEas.com/support/downloads](http://www.RFIdEas.com/support/downloads)

![Image 4: pcProx Config Utility Configuration](image)

Open the pcProx Config utility.

Click on the radio button under Ethernet next to “TCP/IP”

Enter the IP address of the reader and click connect
Once connected, the reader will appear in the device list drop down menu.

Configure the data format, timing or other settings as needed and click the write active.

For pcProx Plus models, choose the configuration number from the drop down menu and then choose the appropriate ID type for each configuration. When finished choose write active from the menu bar.

Configuring Multiple Identical Readers

If you need to configure more than one reader with the same configuration settings the process can be simplified by using hardware configuration files.

To create one, set up a reader to the configurations needed in the end application.

Once the settings are edited on the first reader by “Write Active”; save them to a template file.

To do so:

1. Click on File ➤ Save device data to Hwg+ file
2. Type in an easy to remember name for your file.
3. Save the file to a known directory on your PC.
4. Disconnect the reader.
5. Connect the next reader to be configured.
6. Click Connect from the menu bar.
8. Navigate to the directory where the file was previously saved.
9. Click on the file and then click Open.
10. Click on “Write Active” from the menu bar.

The settings are now activated on the new reader. Repeat this process for each reader in the installation.

2.8 Configuring the Reader Through ACP Commands

The E/IP PoE for PLC reader uses some ACP commands internally. However, there are many commands that can be used to choose configuration ID types, change data formatting and adjust parity bits among other commands.

In listen mode, the reader uses delimiters for framing the ID data. Any changes to pre or post data delimiters will be over-written by the reader.

In polling mode, all pre and post delimiters are not used.

This manual will provide a brief overview for accessing the commands and their general structure.

For more information or to see a full list of available commands, see the ASCII Command Protocol manual.
**ACP Overview**

ASCII Command Protocol (ACP) allows direct configuration of the device without downloading an application or creating a proprietary interface. The feature is available on CDC, Serial, PoE and Ethernet based readers.

The serial pcProx reader communicates using ASCII commands. The reader then parses the command, performs the operation, and may display the result or an error code.

All command strings begin with the prefix `rfid:` and end with a Return key (Enter), CR or LF.

**Communication**

Ethernet and PoE based readers will communicate through a serial tunnel over the Ethernet connection. The E/IP PoE readers will require a telnet session to communicate to the reader.

ACP commands can be sent directly to the reader through the serial tunnel port. This port is defaulted to port 10001 unless changed within the configuration setup menu accessed through the web browser.

From Windows

Go to **Start** ➜ **Run** and type **CMD** then press **Enter** to open a dos window
(From Windows 7, Go to **Start** then type **CMD** in the search box and press **Enter**)

At the command prompt, begin a telnet session by typing: `telnet {IP address} 10001`
(In the area labeled `{IP address}`, enter the IP address assigned to the reader).

Example: `c:\>telnet 52.46.49.44 10001`

![Image 5: Telnet Help](image)

When the telnet session is started, press **Enter** to display the RF IDeas prompt.
At the prompt, type `RFID:HELP` to see a listing of variables and their command syntax.

To see what the reader is currently set to for the current configuration type `RFID:VAR`.

Make the necessary changes to the reader configuration.

Type `RFID:CFG.WRITE` to save the changes (in RAM) to FLASH memory and activate the settings that were modified.

**Command Structure**

Commands are not case sensitive. Characters assigned to variables however, are case sensitive.

- All commands begin with `rfid` followed by one or more token strings with a period delimiter character between multiple tokens.
- Functions must end with a CR or LF.
- Any control characters other than CR, LF, and backspace terminate the command.
- Variables can be assigned a value with an equal sign followed by the value or queried with a question mark.
- The `Escape` key cancels a command.

The general syntax is:

```
rfid: TOKEN { DELIMITER TOKEN } { { =Value} | {?} }
```

Command structure falls into one of three groups:

1. Perform a function
2. Assign a variable
3. Query a variable

**Perform a Function**

A function performs an operation that may or may not display any results. A function may not be queried.

An example of a function is to write the variable settings to flash memory using `rfid:cfg.write CR`.

Certain functions that display a value or series of values display the string between curly braces for easy parsing.

For example, the `rfid:qid` function output displays:

```
{0x00BB,1,0x00,80;0x000000801CD1931B2F14}
```
Assign a Variable

There are three types of variables:

1. Boolean
2. Integer
3. Character

Examples of Boolean Assignments
rfid:op.beep=0
rfid:op.beep=true
rfid:op.beep=False
rfid:op.beep=F

Examples of Integer Assignment
rfid:out.led=0003
rfid:out.led=3

All 16 bit integer values require a hexadecimal entry.
For Example: pcProx Plus card types: rfid:cfg.card.type=0xEF04

Examples of Character Assignment
rfid:Delim.Chr.fac=':' CR
rfid:Delim.Chr.fac='x3a' CR

Examples of pcProx Plus Configuration
To set configuration #1 to read Mifare CSN the following commands would be entered:
rfid:cfg=1 CR
rfid:cfg.card.type=0x7F41 CR
rfid:cfg.write CR

The reader will then respond with {ok}

To then set configuration #2 read HID proxII the following commands would be entered:
rfid:cfg=2 CR
rfid:cfg.card.type=0xEF04 CR
rfid:cfg.write CR

The reader will then respond with {ok}
Query a Variable

A Variable can be queried to display its current value. Variables are set and stored in RAM and are lost when the utility is closed. Use rfid:var to display the list of current ram settings.

The rfid:cfg.write function writes the RAM variables to flash memory. If a variable is changed incorrectly, the settings can be replaced with those from flash using the rfid:cfg.read command.

The output of the variable displays between curly braces.

Example:  RF IDeas>rfid:out.led?

   {3}

Booleans display as true or false.
Chapter 3. RS Linx Classic

3.1 RS Linx Classic Setup

From your development PC Start Menu, choose Rockwell Software ➔ RSLinx ➔ RSLinx Classic.

The Reader once configured with a proper IP address and subnet mask will appear in RSLinx Classic as an unknown Ethernet/IP device.

An EDS file is available to give the entry a familiar look and provide addressing information to RSLinx Classic for configuration.

![Image 6: Rockwell Automation EDS Wizard](image)

**EDS File Installation**

The EDS file can be downloaded from the RF IDeas website at: [www.RFIDeas.com/support/downloads](http://www.RFIDeas.com/support/downloads)

To Install the EDS file:

1. From the Start Menu, Choose Rockwell Software ➔ RSLinx ➔ Tools ➔ EDS Hardware Installation Tool.
2. Click Add in the window that appears.
3. Click Browse in the next screen and navigate to the location where the files were saved and click Open.
4. Click Next. The file will be checked for integrity.
5. Click Next. A prompt to change the associated icon with another of your choosing will appear. If the icon is in the same directory, it will find it. RF IDeas embeds an icon within the...
file. Depending on your version, the icon file may not be necessary.

6. Click Next. This will bring up the Final Task Summary.

7. Click Next. The “Please wait as the EDS wizard installs the new files...” message may appear.

8. Click Finish.
Chapter 4. Rockwell Setup

4.1 Rockwell Studio 5000 Setup

RS Logix 5000 has changed to Studio 5000. The configuration within Studio 5000 relies on the EDS file settings to create an Add-On Profile specific to the RF IDeas Reader. This step assumes that the EDS file has been downloaded and installed successfully to RS Linx Classic.

The file can also be installed as shown below.

Once the EDS file has been installed; refer to Ethernet/IP Module setup under this section for help on configuring the New Module.

**EDS File install**

1. From within Studio 5000's menu bar, Choose Tools ➜ EDS Hardware Installation Tool and click Ok.
2. Click Next.
3. On the options menu, choose Register an EDS file(s) and click Next.
4. Make sure "Register a single file" is selected and click the Browse button.
5. Navigate to where the EDS file was unzipped to, click on the EDS file and click on Open.
6. The EDS wizard will test the file integrity.
7. Click Next. A prompt to change the associated icon with another of your choosing will appear. The icon will be found if it is in the same directory. RF IDeas embeds an icon within the file. Depending on your installation, the icon file may not be necessary.
8. Click Next. This will bring up the Final Task Summary.
9. Click Next. The “Please wait as the EDS wizard installs the new files...” message may appear.
10. Click Finish.
11. Studio 5000 is now ready for module installation.
1. From the Controller Organizer side menu, go to the I/O Configuration folder then locate the “Ethernet” sub-item.

2. Right click on the Ethernet sub-entry and choose “New Module”.

3. From the select Module dialog box, choose the RDR-80x81AKB-P Catalog Number and choose create. For quicker browsing, click on the "Module Type Vendor Filters" check box, then click the check box next to “RF IDeas, Inc.”

4. Fill in the Name field with the chosen reader name.

5. Optionally, fill in the Description field as appropriate for the project notes.

6. Under the Ethernat Address box, type the IP Address assigned through the BootP server.

7. Under Module Definition, Click on Change.

8. From the “Module Definition” window, the “I/O Connection – Unused Output” option will be displayed under “Connections”.

9. If desired, the Connections option can be changed to “I/O Connection with Output” by clicking on the Name field and choosing it from the drop-down menu.

10. Verify the settings are correct for the project configuration and click Ok.

11. Under the New Module Connection Tab, adjust the RPI level as needed. The recommended RPI is 80ms, but can be adjusted as needed.

12. When finished with the New Module configuration, click Ok.

13. A new Ethernet object will appear in the Controller Organizer labelled “RDR-80x81AKB-P”.

Image 7: Module Setup
4.2 RS Logix 5000 Configuration Release 13 Through 19

RS Logix 5000 release 13 through 19 supports the RF IDeas Ethernet IP based Reader. The EDS file is not used in the RS Logix 5000 configuration.

The following steps will guide you through configuration using a Generic Ethernet Module.

1. Open the intended project in the RS Logix 5000 program.
2. In I/O configuration under the Controller Organizer, locate the Ethernet port.
3. Under the Ethernet I/O configuration, add a Generic Ethernet Module.
4. In the Name dialog box, enter a descriptive name to identify the module.
5. For Comm format, select ‘Data-SINT’ from the drop-down menu.
6. In the module properties menu, set the IP address of the PoE reader.
7. Set an Input assembly instance to 100 and set the size to 38 bytes.
8. Add an Output assembly instance 111 with a size of 4 bytes to control the reader LED and/or beeper from within the PLC Main Program. If no control of the reader LED or Beeper will be necessary, Set an Output assembly instance to 110 and set the size to 2 bytes. See Input/Output Assembly options.
9. Set the Configuration Assembly Instance to 128 with a size of 0 bytes as this is unused.
10. Click ok to add the module to the configuration. The reader is now configured.

The assembly instance direction is always related to the origination. Input Instance refers to data flow from the Controller to the device and an output instance refers to data flow from the device to the Controller.

### 4.3 Control Tags

Once configured, there will be three entries in the Control tags menu. Each will have the name of module specified in step 4 (above) followed by C, I and O. These refer to the Control, Input and Output respectively.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Description</th>
<th>Offset</th>
<th>Description</th>
<th>Offset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sequence Low</td>
<td>0</td>
<td>Unused</td>
<td>0</td>
<td>LED Control</td>
</tr>
<tr>
<td>1</td>
<td>Sequence High</td>
<td>1</td>
<td>Unused</td>
<td>1</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>LUID Low</td>
<td>2</td>
<td>Reserved</td>
<td>2</td>
<td>Reserved</td>
</tr>
<tr>
<td>3</td>
<td>LUID High</td>
<td>3</td>
<td>Beeper Control</td>
<td>3</td>
<td>Beeper Control</td>
</tr>
<tr>
<td>4</td>
<td>Bit Count of ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Zero Padding</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6…37</td>
<td>ID Data Bytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Input Assembly 100 Offset Options**

Input assembly parameters are derived from ACP command and function calls. See the ACP command list for more information.

**Sequence No. (offset 0:1)**
Location of sequence number. The number is incremented to indicate a change in ID data and Bit Count.
LUID (offset 2:3)
Logical Unit ID – Unique Identifier for the Reader (if assigned during reader configuration)

ID Bit count / Present (offset 4)
Total bit count of incoming ID in Polling mode

Zero Padding offset 5
Unused byte to separate Bit count from Card ID

Card ID data bytes offsets 6 through 37
Location of ID raw data

See “Internal mode” under “Entering the configuration menu from a web browser” section and/or “1 – ACP Client Configuration” under “Telnet Menu Options” for more information on polling and listen modes.

Output Assembly 110 Offset
Output assembly parameters were not used for the 110 instance. Setting the Output Assembly instance to 110 is used only if control of the reader’s internal LED or beeper will not be made in the intended PLC application.

Output Assembly 111 Offset Options
Output assembly parameters are derived from ACP command and function calls. See the ACP command manual for more information.

LED Control offset 0:
0 (0x00) = Off – Turn off the LED
1 (0x01) = Red – Illuminate the Red LED
2 (0x02) = Green – Illuminate the Green LED
3 (0x03) = Amber- Illuminate both LED’s for Amber
255 (0xFF) = Allow the reader to automatically control the LED (Red – no card data, Green – valid card data received)

Beep Now Offset 3
The reader is capable of playing a short beep or long beep. The reader will sound one short beep by default when a card is read unless disabled in the reader.

Sending the commands below will sound the reader’s beeper immediately after received:

1 (0x01) = Short Beep – A short beep is played
2 (0x02) = Two Short Beeps – a short beep is repeated twice
3 (0x03) = Three Short Beeps – a short beep is repeated 3 times
4 (0x04) = Four Short Beeps – a short beep is repeated 4 times
5 (0x05) = Five Short Beeps – a short beep is repeated 5 times
101 (0x65) = One Long Beep – a Long beep is played
102 (0x66) = Two Long Beeps – a long beep is repeated twice

When sending updated values for the LED and Beeper state to the reader it is important to note that only changes from a previous value will be sent to the reader. The previous value should be cleared at least 200ms prior to sending the same value again. For example, sending “2” to output 111 byte 3 will make the reader beep twice. To beep twice again: clear the previous output value by sending “0”, wait 200ms, then send “2” again.

4.4 Obtaining User Credential Data

When a credential is presented to a configured reader the reader will send data to the input tag bytes 6 through 37. Byte 37 will contain the LSB of the card data. Typical cards will provide data in Bytes 34 through 37.

The configuration of the data will vary depending on the configuration of the reader, credential used and the format of the ID data.

Typically, bit distribution is used to merge the individual data bytes together into a single string for comparison to a database of known ID’s.

The typical program will use the Bit Count or Sequence Low input field as triggers for incoming data.

Using Bit Distribution

![Image 10: Bit Distribution](Image10-BitDistribution)
With the BTD (Bit Distribution) command, the Input data bytes can be combined into a single tag. As shown, bytes 34 through 37 are joined to obtain a 32-bit ID field which is stored in a DINT tag called ID_RCVD.

The bit count field pcProx8:IData[4] is used on rung 0 as a trigger for incoming data.

The sequence number is being stored on rung 1 and the Data from bytes 34 through 37 are distributed into a holding tag “ID_RCVD” on rung 2.

After storing the new data, this subroutine jumps to a database for processing.
Specifications subject to change without notice.

Windows, Macintosh, Solaris, Sun Ray and Linux are trademarks of their respective companies.
All other trademarks, service marks and product or service names are property of their respective owners.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. RF IDeas assumes no responsibility with regard to the performance or use of these products. All understandings, agreements, or warranties, if any, take place directly between the vendors and the prospective users.

Please feel free to call, e-mail or visit our web site for a full list of applications, products, configuration options, supported cards and form factor specifications. Our web site includes application videos, support materials, case studies and detailed information about our product line.

Every effort has been made to ensure that the information in this manual is accurate. RF IDeas is not responsible for printing or clerical errors.